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Chapter 1 Getting Started

This chapter lists LightTools system and licensing requirements and tells you how to contact 
LightTools Support.

System Requirements
To install LightTools, you must have:

• A personal computer with an x64 Intel or AMD processor running the Windows 10 or Windows 
11 operating system.

To get maximum performance from multi-threaded simulations, we recommend 4 to 16 CPU 
cores. LightTools simulation performance scales well with the number of cores, so a computer 
with 12 or 16 cores can secure an almost linear increase in performance.

• Random Access Memory (RAM): 8 GB minimum, 16 GB recommended (or more for large 
models or large simulations) 

• Free disk space as listed to install LightTools components:

• Free disk space on the system drive (i.e., the drive on which the operating system is installed) for 
prerequisite software and for processes and temporary files required when running the product: 
10 GB. If LightTools is installed on a drive other than the system drive, that drive should also have 
at least 10 GB free disk space. Large models and complex analyses may require significantly more 
disk space.

• Display:

– A monitor supporting 1280 x 1024 or better resolution, with 16-bit (65536) colors or more. 
LightTools supports monitors with high resolution or high DPI (dots per inch).

– An OpenGL compliant graphics card with stable ICD driver support recommended. We 
recommend that you always use the latest version of the driver for your graphics card.

• To access and navigate between documents in the LightTools Document Library, which are 
provided as Portable Document Format (PDF) files, it is recommended that you have Acrobat 
Reader version 8.x or higher installed on your computer and set as your default PDF viewer. For 

Component Disk Space

Base LightTools product 3353 MB, plus virtual memory equal to 3 times the RAM

Online documentation 144 MB

Tutorial Files 131 MB

Data Exchange Modules, 
excluding CATIA V5

450 MB

CATIA V5 Modules 1588 MB

SOLIDWORKS Link Module 72 MB
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many systems, the default PDF viewer is a browser (e.g., Edge, Chrome), which does not support 
PDF features such as links that you can click to jump to another document.

• A DVD drive, if installing from a DVD

Licensing Requirements
LightTools provides the following methods for licensing. Before you install LightTools, you need to 
know which method is appropriate for you to use.

• LightTools Legacy Licensing - Used in releases up to and including LightTools 2024.03. 
Customers who are updating from a previous version of LightTools should continue to use Legacy 
Licensing unless instructed otherwise by a Synopsys Optical Solutions representative (or local 
application license administrator).

• Synopsys Common Licensing - Available for new customers beginning with LightTools 2024.03.

Your LightTools or IT administrator should be able to provide you with information about the 
licensing method you need to choose. If you need additional information to help you choose, see:

https://www.synopsys.com/optical-solutions/support/choosing-license-option.html

For requirements specific to each licensing method, see About LightTools Legacy Licensing on page 7 
and About Synopsys Common Licensing on page 7.

To install LightTools with either of these licensing methods, you must have license keys provided by 
Synopsys Optical Solutions via SolvNetPlus SmartKeys or your local LightTools software distributor. 

The following modules require a separate license:

• LightTools Core Module

• LightTools Illumination Module

• LightTools Distributed Simulation Module

For this module, you must have a license for each worker session, and you must have a floating 
license. You must also install the Intel Message Passing Interface (MPI) on each host running 
worker sessions that participate in simulations. MPI requires 68 MB of disk space, and the MPI 
executable is provided on the SolvNetPlus website Downloads page with the product software.

For details about installing this module, see the Distributed Simulation Module User’s Guide in 
the LightTools Document Library, which is included in the LightTools installation (select Help > 
Document Library or Windows Start > LightTools(64) 2024.03 > Document Library).

• LightTools Optimization Module

• LightTools SmartStart Library Module

For details about installing this module, see the Appendix C,"Using the LightTools SmartStart 
Library" in the LightTools Core Module User’s Guide, which is included in the LightTools 
installation (select Help > Document Library or Windows Start > LightTools(64) 2024.03 > 
Document Library).

• LightTools MetaOptic Design Add-on

• LightTools Advanced Physics Module

Note:  Host IDs are unique to each method of licensing and are not interchangeable.

https://www.synopsys.com/optical-solutions/support/choosing-license-option.html
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• LightTools Advanced Design Module

• LightTools Imaging Path Module

• LightTools SOLIDWORKS Link Module

For the LightTools SOLIDWORKS Link Module, you need a licensed version of SOLIDWORKS 
2020 or later (with the latest service pack, if possible) installed on the same computer as 
LightTools.

• LightTools Parasolid Exchange Module

– LightTools STEP Exchange Module
– LightTools IGES Exchange Module
– LightTools SAT Exchange Module
– LightTools CATIA V4 Exchange Module
– LightTools CATIA V5 Import Module
– LightTools CATIA V5 Export Module

About LightTools Legacy Licensing
With Legacy Licensing, you can run LightTools using either a fixed license or a floating license. A 
fixed license allows you to run LightTools only on the computer on which it is installed (see Installing 
LightTools with a Fixed License (Legacy Licensing) on page 9). A floating license, which is installed 
on a network server, allows you to run LightTools on any computer on the same network (see 
Installing and Managing the OSG Floating License (Legacy Licensing) on page 17). The number of 
users that can use LightTools concurrently is limited by the licensing software.

To install LightTools with Legacy Licensing, you must have:

• A dongle provided by Synopsys and a USB2.0 (or higher) port (for Type A)

• If you will be running LightTools with a floating license, you must also have:

– TCP/IP network protocol

– Floating license manager software provided by Synopsys OSG. This guide provides 
instructions for installing the OSG Floating License Manager (a Sentinel RMS license manager 
that has been customized for Synopsys OSG software), which is provided on SolvNetPlus. See 
Using SolvNetPlus to Obtain LightTools Software and Licenses on page 51 for details.

About Synopsys Common Licensing
With Synopsys Common Licensing, you can run LightTools using either a nodelocked or network 
license. A nodelocked license allows you to run LightTools only on the computer on which it is 
installed (see Installing LightTools with an SCL Nodelocked License on page 35). A network license, 
which is installed on a network server, allows you to run LightTools on any computer on the same 
network (see Installing and Managing an SCL Network License on page 41).

To install LightTools with Synopsys Common Licensing, you must have:

• Synopsys Common Licensing (SCL) software, which is included in the LightTools installer. This 
guide provides instructions for installing SCL.

• If you will be running LightTools with a network license, you must also have:

– TCP/IP network protocol
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System requirements for a Synopsys Common Licensing server are available here: https://
www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-
os.html.

A dongle is not required with SCL, but if one is required at your site, you must have:

• A dongle provided by Synopsys and a USB2.0 (or higher) port (for Type A)

Contacting LightTools Support
Need expert help using our software?

• Open a support ticket in SolvNetPlus. Learn more about how to access and use SolvNetPlus.

• Send an email to lighttools_support@synopsys.com.

• Explore the SolvNetPlus Knowledge Base, which features searchable technical articles, example 
files, macros, release notes, FAQs, and more, available at any time. First log in to SolvNetPlus, 
then go to the Collection of Optical and Photonic Solutions Knowledge Article.

• Visit our main Support page for an overview of how to access product learning, self-help, and 
other resources.

• Visit our Licensing and Installation Help page.

• View our list of global support contacts.

https://solvnetplus.synopsys.com/s/
https://www.synopsys.com/optical-solutions/support/solvnetplus.html
mailto:lighttools_support@synopsys.com
https://solvnetplus.synopsys.com/s/article/Optical-Photonic-Solutions-Support
https://solvnetplus.synopsys.com/s/
https://solvnetplus.synopsys.com/s/article/Optical-Photonic-Solutions-Support
https://www.synopsys.com/optical-solutions/support.html
https://www.synopsys.com/optical-solutions/support/support-install-lic-overview.html
https://www.synopsys.com/optical-solutions/support/support-global-contacts.html
https://www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-os.html
https://www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-os.html
https://www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-os.html
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Chapter 2 Installing LightTools with a Fixed 
License (Legacy Licensing)

With LightTools Legacy Licensing, you can run either a fixed license or a floating license. This 
chapter describes how to install the product to run using a fixed license, which allows you to run 
LightTools only on the computer on which it is installed. With this license, you can open up to eight 
concurrent LightTools sessions.

These instructions assume that you have already downloaded LightTools from the Synopsys 
SolvNetPlus website via electronic software transfer (EST) or that you ordered and received a 
LightTools DVD. It is also assumes that you have obtained license keys. If you have not done so, see 
Using SolvNetPlus to Obtain LightTools Software and Licenses on page  51.

Installing LightTools
1. Log on to your computer as Administrator.

2. Navigate to the folder where the LightTools installation file LightTools64_2024.03FCS.zip is 
located. 

3. Right-click the file and select one of the extract options on the pop-up menu, shown in the 
following figure. For example:

– If you have WinZip, select WinZip > Extract to. In the WinZip Extract dialog box, navigate to 
the desired location on your local drive and click Unzip.

– If you have 7-Zip, select 7-Zip > Extract files. In the Extract dialog box, navigate to the desired 
folder and click OK.

– If you have the Windows extract tool, select Extract All. In the Extract Compressed (Zipped) 
Folders dialog box, navigate to the desired folder and click Extract.

4. When the extraction is complete, navigate to the folder to which the files were extracted.

5. Double-click the file setup.exe.

If a User Account Control dialog box is displayed with the message Do you want to allow this app 
to make changes to your PC?, click Yes to continue.

6. If you are prompted to install a Microsoft Visual C++ redistributable package or the .NET 
Framework, click the Install button.

The InstallShield Wizard is displayed.

7. Click Next to continue.

The Synopsys End-User Software License and Maintenance Agreement screen is displayed.

8. Click the I accept option and click Next to continue.

The Destination Folder screen is displayed.

9. To accept the default location for the program and Shared Data files, click Next.

The License Installation Options screen is displayed, and the default setting is for a Fixed/
Nodelocked license.
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Of these four options, three are appropriate to use for a fixed license configuration, as described 
below.

– I have a license file for a Fixed/Nodelocked license: Use this default option to provide your 
license file and allow LightTools to detect the licensing method. Click Next, Browse to the 
license file and select it, and click Open. Go on to step 10.

– I want to connect to a license server to use a Floating/Network Client license: This is not a 
valid option for this procedure.

– Let me specify the licensing method manually: Select this option if you already know and 
prefer to specify the licensing method. Click Next, make sure that LightTools Legacy 
Licensing is selected, make sure that Fixed License is selected. Go on to step 10.

– Install LightTools without setting up licensing: This option allows you to install LightTools 
without providing a license file at this time. Go on to step 10.

10. Click Next to continue.

The LightTools Setup Type screen is displayed, shown in the following figure. 

11. Select the type of installation you would like to run and click Next.

Note:  During a Complete installation, all LightTools features are automatically installed, including 
the large CATIA V5 data exchange module. If you do not intend to license and use the CATIA V5 
module, you can choose the Typical setup option to install all features except the CATIA V5 
module, or select the Custom setup option, which allows you to manually control which features 
are installed.
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12. On the Ready to Install the Program screen, click the Install button to begin installing LightTools.

13. When the installation is complete, click Finish to close the wizard.

If you already have a license key for this product, skip to Installing a License Key for a Fixed 
License on page  12. If you do not yet have a license key, continue with Obtaining the Host ID for 
a Fixed License on page  11.

Obtaining the Host ID for a Fixed License
A license key is designed to work for only one USB dongle, so the license key is associated with a 
unique value encoded on the dongle called a Host ID. Because of this, you need to know the Host ID 
for the license dongle before you can retrieve a license key. The Host ID is printed on a label on the 
USB dongle; if you’re unable to read the ID on the label, you can also obtain the Host ID by running a 
program that reads it from the dongle. In the LightTools installation, the GetHostID utility is provided 
for this purpose. Follow these steps to run the GetHostID utility.
1. Insert the USB dongle in an active USB port. 

2. Click the Windows Start button and select LightTools > GetHostID.

The GetHostID utility is displayed, as shown in the following figure. The Host ID is displayed 
below the Read Dongle Host ID button (in this example, 400*-*16TL6BDC7J3FHJN).
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3. Copy the Host ID to use when you retrieve your license key on the Synopsys SolvNetPlus 
website. See Retrieving License Keys on page  58 for instructions.

4. Click Done to close the GetHostID utility.

After you retrieve your license key, go to Installing a License Key for a Fixed License on page  12.

Installing a License Key for a Fixed License
To install the license key for LightTools, you must have:

• LightTools installed (see Installing LightTools on page  9)

• A license dongle

• A valid license key (in previous releases, license keys were called license codes.) This procedure 
assumes that you have already obtained license keys from the SolvNetPlus SmartKeys web page. 
If you have not done so, see Retrieving License Keys on page  58 for instructions.

Follow these steps to install your license key.

1. Insert the license dongle in an active USB port. 

2. To install your license key, click the Windows Start button and select LightTools > Fixed License 
Installer 

Note:  If you try to start LightTools before you install your license key, the License Manger Error 
dialog box is displayed. Click the Install License button on that dialog box to display the Fixed License 
Installer and follow steps 3 through 6.
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The Fixed License Installer is displayed, shown in the following figure.

3. Click the Browse button .

4. In the Open dialog box, navigate to the license file, select it, and click Open. 

The Open dialog box is closed, and the path to the license key file is shown in the Fixed License 
Installer.

5. Click the Install button.

The license key is installed, and the Success dialog box is displayed.

6. Click OK.

LightTools starts automatically.rnrc
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Modifying License Options for LightTools Legacy Licensing
If you need to change the type of license (e.g., fixed or floating) for your LightTools installation, 
follow these steps.

1. Open the InstallShield Wizard:
– If you have a LightTools DVD, insert it into the DVD drive and choose Modify > Change 

Licensing Options.
– If you do not have a DVD, follow these steps:

a. Click the Windows Search icon, enter prog, and select Add or remove programs in the 
results list. 

b. In the Settings dialog box, locate and click LightTools in the list of Apps & Features. 

Buttons labeled Modify and Uninstall are displayed below the LightTools program name.

c. Click the Modify button.

2. When the InstallShield Wizard is displayed, click Next. 

3. On the Program Maintenance screen, make sure the Modify option is selected and click Next. 

4. On the Installation Options page, click the option for Change Licensing Options and click Next.

5. On the License Installation Options page, select the type of license that will be used. If you select 
Floating License, enter the Server Hostname as well.

6. Click Next.

7. On the Ready to Modify the Program page, click Install.

When the licensing option has been updated, the wizard displays the InstallShield Wizard 
Completed screen.
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8. Click Finish to close the wizard.

Invisible anchor
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Chapter 3 Installing and Managing the OSG 
Floating License (Legacy Licensing)

With LightTools Legacy Licensing, you can run either a fixed license or a floating license. This 
chapter describes how to install the product to run using a floating license on a network server, which 
allows you to run LightTools on any computer on the same network, and describes how to install 
LightTools on one or more client machines. 

The number of users that can use LightTools concurrently is limited to a predetermined number by the 
licensing software. A single user can open up to eight concurrent LightTools sessions per floating 
license per computer. If a user opens more than eight concurrent LightTools sessions on the same 
computer, an additional floating license will be used (if available).

The floating license capability for LightTools Legacy Licensing is supported by the OSG Floating 
License Manager, which is a Sentinel RMS license manager that has been customized for Synopsys 
OSG software. If you install other Synopsys OSG software products, they will use the same license 
management software, and their license keys will be written to the same license key file.The 
applications cannot share license keys; they share only the license server software.

The steps for installing LightTools to run with a floating license are:

1. Selecting a License Server on page 17

2. Downloading and Installing the OSG Floating License Manager on page 18

3. Obtaining the Host ID for a Floating License on page 20

4. Installing a License Key for a Floating License on page 21

5. Installing LightTools on Client Machines on page 22

6. Optional: Managing Floating Licenses on page 27

7. Optional: Logging Floating License Usage on page 32

Selecting a License Server
Before installing any software, you must identify the computer that will act as the license server. This 
must be a computer connected to a network that can grant access to one or more client machines.

You can run the OSG Floating License Manager on the following operating systems: Windows 10, 
Windows 11, Windows Server 2016, and Windows Server 2019.

Note:  Installing a floating license requires system-administration-level training and should be 
performed by someone who is familiar with your network structure. To perform this installation, you 
must be logged on as administrator.

Note:  The OSG Floating License Manager communicates via port 5093 using the user datagram 
protocol (UDP). If you will be running LightTools across different subnets, you will have to configure 
your routers or firewalls to allow two-way communication across this port.
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Downloading and Installing the OSG Floating License Manager
To run this version of LightTools, you must have the latest version of the OSG Floating License 
Manager, which is provided on the SolvNetPlus website on the same Downloads page as the product 
software. (See Using SolvNetPlus to Obtain LightTools Software and Licenses on page 51 for details.) 
Follow these steps to install the OSG Floating License Manager on the license server.

1. Log on to the license server with administrator privileges.

2. If any version of the OSG Floating License Manager or the Sentinel RMS License Manager 
software is installed on the license server computer, you must uninstall it using the following sub-
steps. If no prior version is installed, skip to step 3.

a. Open the Control Panel and select Programs and Features. 

b. If the list includes both the OSG Floating License Manager Admin Tools and the Sentinel RMS 
License Manager, shown in the following figure, you must uninstall both of these.

c. Select the program to uninstall and then click Uninstall/Change.

d. Follow the instructions on screen. 

3. Navigate to the folder where you downloaded the OSG Floating License Manager, 
FloatingLM.exe.

4. Double-click the file FloatingLM.exe.

The Welcome screen for the OSG Floating Manager Admin Tools wizard is displayed.

5. Click Next.

The License Agreement screen for the OSG Floating License Manager Admin Tools is displayed.

6. Click the I Accept option and click Next to continue.

The Ready to Install screen is displayed.

7. Click Install.

The progress screen is displayed while the software is installed, and then the Welcome screen for 
the Sentinel RMS License Manager is displayed.

8. Click Next.

The License Agreement screen for the Sentinel RMS License Manager wizard is displayed.

Note:   If you have a different version of the Sentinel RMS software, you must first uninstall the older 
version, as described in step 2.
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9. Click the I Accept option and then click Next to continue.

The Customer Information dialog box is displayed.

10. Click Next to accept the defaults and continue.

The Destination Folder screen is displayed.

11. Click Next to accept the default and continue.

The Setup Type screen is displayed. 

12. Click Next to accept Complete (recommended) and continue.

The System Firewall Settings screen is displayed.

13. Leave the option turned on (checked) and click Next.

This setting allows the Floating License Manager to add inbound rules. If you change this setting, 
LightTools will not be able to obtain the license needed to run.

The Ready to Install screen is displayed.

14. Click Install.

The progress screen is displayed while the software is installed.

When the installation is finished, the Completed screen for the Sentinel License Manager is 
displayed.

15. Click Finish.

The Completed screen for the OSG Floating License Manager Admin Tools is displayed.

16. Click Finish.

The installation is complete. 

17. Reboot your computer if prompted to do so.

If you already have a license key for this product, skip to Installing a License Key for a Floating 
License on page 21. If you do not yet have a license key, continue with Obtaining the Host ID for a 
Floating License on page 20.
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Obtaining the Host ID for a Floating License
A license key is designed to work for only one USB dongle, so the license key is associated with a 
unique value encoded on the dongle called a Host ID. Because of this, you need to know the Host ID 
for the license dongle before you can retrieve a license key. The Host ID is printed on a label on the 
USB dongle; if you’re unable to read the ID on the label, you can also obtain the Host ID by running 
a program that reads it from the dongle. In the OSG Floating License Manager installation, the 
GetHostID utility is provided for this purpose. Follow these steps to run the GetHostID utility.
1. Insert the USB dongle in an active USB port on the license server. 

2. Click the Windows Start button and select OSG Floating License Manager > GetHostID.

The GetHostID utility is displayed, as shown in the following figure. The Host ID is displayed 
below the Read Dongle Host ID button (in this example, 400*-*16TL6BDC7J3FHJN).

3. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See 
Retrieving License Keys on page 58 for instructions.

4. Click Done to close the GetHostID utility.

After you retrieve your license key, go to Installing a License Key for a Floating License on page 21.
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Installing a License Key for a Floating License
After you install the license server software and retrieve a license key, you need to install the license 
key on the license server before client machines can successfully run LightTools. The Floating 
License Installer is provided for this purpose. 

This procedure assumes that you have already obtained a valid license key from the SolvNetPlus 
SmartKeys web page. If you have not done so, see Retrieving License Keys on page 58 for 
instructions.

Follow these steps to install your license key file.

1. Make sure that the license dongle is inserted in an active USB port on the license server. 

2. Click the Windows Start button and select OSG Floating License Manager > Floating License 
Installer.

The Floating License Installer is displayed, as shown in the following figure.

3. Click the Browse button .

4. In the Open dialog box, navigate to the license key file, select it, and click Open.

The Open dialog box is closed, and the path to the license key file is shown in the Floating License 
Installer.
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5. Click the Install button.

The license key file is installed, and the Success dialog box is displayed.

6. To close the Floating License Installer, click the X in the top right corner.

Continue with Installing LightTools on Client Machines on page 22.

Installing LightTools on Client Machines
LightTools must be installed on each client machine where it will be used. During the installation, you 
select Floating License as the license type and then specify the name of the server, which is the 
computer on which the license manager is installed.

These instructions assume that you have already downloaded LightTools from the Synopsys 
SolvNetPlus website via electronic software transfer (EST) or that you ordered and received a 
LightTools DVD. If you have not done so, see Using SolvNetPlus to Obtain LightTools Software and 
Licenses on page 51.

1. Log on to your computer as Administrator.

2. Navigate to the folder where the LightTools installation file LightTools64_2023.03FCS.zip is 
located. 

3. Right-click the file and select one of the extract options on the pop-up menu, shown in the 
following figure. For example:

– If you have WinZip, select WinZip > Extract to. In the WinZip Extract dialog box, navigate to 
the desired location on your local drive and click Unzip.
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– If you have 7-Zip, select 7-Zip > Extract files. In the Extract dialog box, navigate to the desired 
folder and click OK.

– If you have the Windows extract tool, select Extract All. In the Extract Compressed (Zipped) 
Folders dialog box, navigate to the desired folder and click Extract.

4. When the extraction is complete, navigate to the folder to which the files were extracted.

5. Double-click the file setup.exe.

If a User Account Control dialog box is displayed with the message Do you want to allow this app 
to make changes to your PC?, click Yes to continue.

6. If you are prompted to install a Microsoft Visual C++ redistributable package or the .NET 
Framework, click the Install button.

The InstallShield Wizard is displayed.

7. Click Next to continue.

The Synopsys End-User Software License and Maintenance Agreement screen is displayed.

8. Click the I accept option and click Next to continue.

The Destination Folder screen is displayed.

9. To accept the default location for the program and Shared Data files, click Next.

The License Installation Options screen is displayed, and the default setting is for a Fixed/
Nodelocked license.

Of these four options, three are appropriate to use for a floating license configuration, as described 
below.

– I have a license file for a Fixed/Nodelocked license: This is not a valid option for this 
procedure.

– I want to connect to a license server to use a Floating/Network Client license: Select this 
option to specify your server name and allow LightTools to detect the licensing method. Click 
Next.

On the next screen, enter the server name. In the following figure, the name OpticServer is used 
as an example; be sure to enter the name of your license server in this field. 
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If you want to enter more than one server name, you can do so, as long as you separate the 
names with a colon, as shown in the following example. The names ServerHostname1 and 
ServerHostname2 are examples; be sure to enter the names of your license servers in this field. 
LightTools checks for a license on servers in the order in which they are listed.

Go on to step 10.

– Let me specify the licensing method manually: Select this option if you already know and 
prefer to specify the licensing method. Click Next, select LightTools Legacy Licensing, and 
click Next again. Select Floating License.

Next to the Server Hostname, enter the name of the computer on which the license manager 
was installed and click Next to continue. In the following figure, the name OpticServer is used 
as an example; be sure to enter the name of your license server in this field. 

If you want to enter more than one server name, you can do so, as long as you separate the 
names with a colon, as shown in the following example. The names ServerHostname1 and 
ServerHostname2 are examples; be sure to enter the names of your license servers in this field. 
LightTools checks for a license on servers in the order in which they are listed.

Go on to step 10.

– Install LightTools without setting up licensing: This option allows you to install LightTools 
without providing a license file at this time. Go on to step 10.
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10. Click Next.

The LightTools Setup Type screen is displayed, shown in the following figure. If you want to 
install LightTools on this computer, continue with the next step. If you do not want to install 
LightTools on this computer, click Cancel and then Finish to complete the installation.

11. Select the type of installation you would like to run and click Next.

12. On the Ready to Install the Program screen, click the Install button to begin installing LightTools.

13. When the installation is complete, click Finish to close the wizard.

Modifying License Options for LightTools Legacy Licensing
If you need to change the type of license (e.g., fixed or floating) for your LightTools installation, 
follow these steps.

1. Open the InstallShield Wizard:
– If you have a LightTools DVD, insert it into the DVD drive and choose Modify > Change 

Licensing Options.
– If you do not have a DVD, follow these steps:

a. Click the Windows Search icon, enter prog, and select Add or remove programs in the 
results list. 

Note:  During a Complete installation, all LightTools features are automatically installed, including 
the large CATIA V5 data exchange module. If you do not intend to license and use the CATIA V5 
module, you can choose the Typical setup option to install all features except the CATIA V5 
module, or select the Custom setup option, which allows you to manually control which features 
are installed.
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b. In the Settings dialog box, locate and click LightTools in the list of Apps & Features. 

Buttons labeled Modify and Uninstall are displayed below the LightTools program name.

c. Click the Modify button.

2. When the InstallShield Wizard is displayed, click Next. 

3. On the Program Maintenance screen, make sure the Modify option is selected and click Next. 

4. On the Installation Options page, click the option for Change Licensing Options and click Next.

5. On the License Installation Options page, select the type of license that will be used. If you select 
Floating License, enter the Server Hostname as well.

6. Click Next.

7. On the Ready to Modify the Program page, click Install.

When the licensing option has been updated, the wizard displays the InstallShield Wizard 
Completed screen.

8. Click Finish to close the wizard.
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Managing Floating Licenses
In general, there is nothing that you need to do to manage the floating licenses. As long as the floating 
license server machine is operational, connected to the network, and is running the Sentinel service, 
licenses are available to clients.

Monitoring License Use
It is possible for all available licenses to be in use, which would prevent additional clients from 
running LightTools. In such cases, a system administrator can use the WlmAdmin utility to determine 
to whom the module licenses have been allocated.

1. To start the utility, click the Windows Start menu and select OSG Floating License Manager > 
Administrator Utility.

2. Expand the list of modules below the license server hostname. 

The details presented in the dialog box indicate which client machine and username have checked 
out the licenses. The example below shows that from the license server machine calico, a 
LightTools Illumination Module (LTLUM) license is checked out to a user named JDoe, who is 
using the client machine sardine.

Note:  To use the WlmAdmin utility, you must be the person who started the license server, or you 
must have administrator privileges.
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You can also use the WlmAdmin utility to obtain other licensing activity information, such as license 
servers detected, details on active licenses, etc. For more information about how to use the 
WlmAdmin utility, see the Sentinel System Administrator’s Guide. After the Sentinel software is 
installed, this manual is available by selecting the Windows Start menu and selecting Programs > 
OSG Floating License Manager > System Administrator’s Guide.

Improving Access to LightTools Licenses with the Sentinel License Manager
By default, LightTools licenses are available to anyone on your server on a first-come, first-served 
basis. Therefore, you can use LightTools immediately without using the Sentinel License Manager. 
However, if you want to control access to these licenses based on work priorities, you can use the 
Sentinel License Manager to reserve copies for or deny access to specific users.

Before using the Sentinel License Manager, consider how you want to organize your groups, keeping 
in mind the following points:

• Anyone on your server can use a license that has not been explicitly reserved.

• After you create a group, you can specify the status of individual members as Included (access 
allowed) or Excluded (access denied).

• You can exclude all members of a group from using licenses (called license tokens) by specifying 
0 licenses for that group.

For example: 

• Organize by department:

If you have departments in your organization, enter each department as a separate group, assign 
the appropriate number of license tokens to each group, and designate each group member as 
Included or Excluded. You can change this designation for members as needed, according to work 
priorities.

• Organize by priority:

Create a group for preferred users and another group for everyone else. In the preferred user 
group, designate all members as Included and assign to them as many licenses as you can allow. 
For the second group, you enter everyone else in the company, assign the remaining license 
tokens, and designate which people are Included and which are Excluded. You can change the 
Included and Excluded designations as the work load changes.

When you are ready to implement this arrangement, you can use the Sentinel License Manager to 
create a reservation file, as described in the following steps. 

1. On the license manager server, start the license manager administration utility by clicking the 
Windows Start button and selecting OSG Floating License Manager > Administrator Utility. 

The WlmAdmin window is displayed.

2. From the menu at the top of the WlmAdmin window, select Edit > Reservation File. 

The Wlsgrmgr window is displayed.

3. To set up a new members group, select File > New. 

4. Follow these steps to select a feature. 

Note:  Not all functions described in the Sentinel System Administrator’s Guide are supported by 
LightTools.
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a. Select Feature > Add. 

The Add License Reservation Wizard is displayed. 

b. Click Next to continue. 

The Feature Version Capacity window is displayed.

c. Enter the appropriate Feature Name.

You must enter feature names as they appear in the WlmAdmin dialog box, shown in the 
following example.

d. For the Feature Version, enter ORA (upper case). 
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e. Click Next. 

The Group window is displayed.

5. To establish a user group, follow these steps.

a. Enter a name that identifies the user group for which you want to allow or deny access. 

b. In the Tokens field, enter the number of licenses to reserve for that group.

c. Click Next. 

The Members window is displayed.

6. To add members to the group, follow these steps. 

Note:  Add members who will be allowed access, as well as members who will be denied access.
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a. Click the Add button.

b. In the Name of the Member field, enter the member’s user name. Members can be defined only 
by user name and not by machine (i.e, client computer name or IP address).

c. Select User.

d. Click Included for members who are allowed access or Excluded for members who are denied 
access.

e. Click OK on the Member window and repeat the process to add each user in the group.

f. Click Finish on the Members window to apply the changes and close the window.

7. Repeat the process of selecting a feature, establishing a group, and adding members for each group 
(steps 4, 5, and 6, above).

8. Select File > Save As and find the directory where the license manager is installed. 

By default, the license manager is installed in C:\Program Files (x86)\Common Files\SafeNet 
Sentinel\Sentinel RMS License Manager\WinNT. A file called lsreserv is created and saved at 
this location. The License Manager references this file to determine which users have access to 
each feature.

9. Restart the Sentinel RMS License Manager, as described in the following steps.

a. From the Windows Start button, select Start.

b. Right-click Control Panel and select Open on the pop-up menu. 
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c. Click System and Security.

d. Select Administrative Tools and then Services. 

e. Locate and right-click the Sentinel RMS License Manager service in the Services dialog box, 
and select the Restart option on the pop-up menu.

Logging Floating License Usage
Floating license usage is automatically recorded in the file usage.log. The following example shows 
how information is formated in this file.

As shown in the highlighted portions, the entries include:

1 - day, date, and time stamp

2 - the product or module

3 - a code that indicates whether the license was issued (0), denied (1), or released (2)

4 - the number of floating licenses in use after the current release or request. 

5 - elapsed time the license was in use (in seconds). This value is 0 until the license is released.

6 - the user ID

7 - the host name

8 - the version number for the floating license manager 

By default, the usage.log file is located in the folder C:\Windows\SYSWOW64. You can change the 
location and name of the file, if desired, as described in the following steps.

1. Select the Windows Start menu and select Control Panel > System.

2. In the top left corner, select Advanced system settings.

3. In the System Properties dialog box, elect the Advanced tab and click Environment Variables.
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4. In the Environmental Variables dialog box, select LSERVOPTS and click Edit.

By default, the value for LSERVOPTS is 

-l usage.log -z 20m -f error.log

5. In the Edit System Variable dialog box, change the path and/or file name by replacing the string 
usage.log with the desired path and file name. In the following example, the new path for the 
file is C:\temp\usage.log. 

6. Restart the license manager in the services list, as described in the following steps.
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The change takes effect after the license manager is restarted.

a. Select the Windows Start menu and select Control Panel > Administrative Tools.

b. Double-click Services.

c. In the Services dialog box, locate and select the Sentinel RMS License Manager.

d. Click Restart the Service option.

For additional information about the usage log, See the Sentinel System Administrator’s Guide. 
After the license manager software is installed, this manual is available by selecting the Windows 
Start menu and selecting Programs > OSG Floating License Manager > System 
Administrator’s Guide.
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Chapter 4 Installing LightTools with an SCL 
Nodelocked License

With Synopsys Common Licensing, you can run LightTools using either a nodelocked license or a 
network license. This chapter describes how to install the product to run using a nodelocked license, 
which allows you to run LightTools only on the computer on which it is installed. With this license, 
you can open up to eight concurrent LightTools sessions.

Installing LightTools with a Nodelocked License
These instructions assume that you have already downloaded LightTools from the Synopsys 
SolvNetPlus website via electronic software transfer (EST) or that you ordered and received a 
LightTools DVD.It is also assumes that you have obtained license keys. If you have not done so, see 
Using SolvNetPlus to Obtain LightTools Software and Licenses on page 51.

1. Log on to your computer as Administrator.

2. Navigate to the folder where the LightTools installation file LightTools64_2023.03FCS.zip is 
located. 

3. Right-click the file and select one of the extract options on the pop-up menu, shown in the 
following figure. For example:

– If you have WinZip, select WinZip > Extract to. In the WinZip Extract dialog box, navigate to 
the desired location on your local drive and click Unzip.

– If you have 7-Zip, select 7-Zip > Extract files. In the Extract dialog box, navigate to the desired 
folder and click OK.

– If you have the Windows extract tool, select Extract All. In the Extract Compressed (Zipped) 
Folders dialog box, navigate to the desired folder and click Extract.

4. When the extraction is complete, navigate to the folder to which the files were extracted.

5. Double-click the file setup.exe.

If a User Account Control dialog box is displayed with the message Do you want to allow this app 
to make changes to your PC?, click Yes to continue.

6. If you are prompted to install a Microsoft Visual C++ redistributable package or the .NET 
Framework, click the Install button.

The InstallShield Wizard is displayed.

7. Click Next to continue.

The Synopsys End-User Software License and Maintenance Agreement screen is displayed.

8. Click the I accept option and click Next to continue.

The Destination Folder screen is displayed.

9. To accept the default location for the program and Shared Data files, click Next.

The License Installation Options screen is displayed, and the default setting is for a Fixed/
Nodelocked license.
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1. Log on to your computer as Administrator.

2. Navigate to the folder where the LightTools installation file LightTools64_2023.03FCS.zip is 
located. 

3. Right-click the file and select one of the extract options on the pop-up menu, shown in the 
following figure. For example:

– If you have WinZip, select WinZip > Extract to. In the WinZip Extract dialog box, navigate to 
the desired location on your local drive and click Unzip.

– If you have 7-Zip, select 7-Zip > Extract files. In the Extract dialog box, navigate to the desired 
folder and click OK.

– If you have the Windows extract tool, select Extract All. In the Extract Compressed (Zipped) 
Folders dialog box, navigate to the desired folder and click Extract.

4. When the extraction is complete, navigate to the folder to which the files were extracted.

5. Double-click the file setup.exe.

If a User Account Control dialog box is displayed with the message Do you want to allow this app 
to make changes to your PC?, click Yes to continue.

6. If you are prompted to install a Microsoft Visual C++ redistributable package or the .NET 
Framework, click the Install button.

The InstallShield Wizard is displayed.

7. Click Next to continue.

The Synopsys End-User Software License and Maintenance Agreement screen is displayed.

8. Click the I accept option and click Next to continue.

The Destination Folder screen is displayed.

9. To accept the default location for the program and Shared Data files, click Next.

The License Installation Options screen is displayed, and the default setting is for a Fixed/
Nodelocked license.

Of these four options, three are appropriate to use for a nodelocked license configuration, as 
described below.

– I have a license file for a Fixed/Nodelocked license: Use this default option to provide your 
license file and allow LightTools to detect the licensing method. Click Next, Browse to the 
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license file and select it, and click Open. Go on to step 10.

– I want to connect to a license server to use a Floating/Network Client license: This is not a 
valid option for this procedure.

– Let me specify the licensing method manually: Select this option if you already know and 
prefer to specify the licensing method. 

a. Click Next, select Synopsys Common Licensing (SCL), and click Next again. 

b. On the License Type Setup screen, select Nodelocked and click Next.

c. Browse to the license file and select it, and click Open.

If you do not yet have a license key file, you can install it later. Click Next and skip to step 
10. When you’re ready to get your license key file, see Select the type of installation you 
would like to run and click Next. on page 37 and Installing a License Key File for an SCL 
Nodelocked License on page 39.

d. On the License Type Setup screen, click Next.

When the progress screen closes in the Setup - Optical/Photonic Solutions Licensing 
wizard, the Synopsys Common Licensing software installation is complete.

The LightTools Setup Type screen is displayed, shown in the following figure.

10. Select the type of installation you would like to run and click Next.

11. On the Ready to Install the Program screen, click the Install button to begin installing LightTools.

12. When the installation is complete, click Finish to close the wizard.

Obtaining the Host ID for an SCL License
A license key is associated with a unique value on your device called a Host ID, and it works for only 
one computer or USB dongle. Because of this, you need to know the Host ID for your computer or 
dongle before you can retrieve a license key file.

Note:  During a Complete installation, all LightTools features are automatically installed, including 
the large CATIA V5 data exchange module. If you do not intend to license and use the CATIA V5 
module, you can choose the Typical setup option to install all features except the CATIA V5 
module, or select the Custom setup option, which allows you to manually control which features 
are installed.
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Obtaining the Host ID for a Computer
If you are not using a dongle, you can use the lmhostid utility installed with Synopsys Common 
Licensing to obtain the Host ID for your computer. Follow these steps to run the lmhostid utility.

1. Click the Windows Start button and select Synopsys SCL > lmhostid 2022.12.

The Host ID is displayed in a command window, as shown in the following example.

2. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See 
Retrieving License Keys on page 58 for instructions.

After you retrieve your license key file, go to Installing a License Key File for an SCL Nodelocked 
License on page 39.

Obtaining the Host ID for a Dongle
If you are using a dongle for Synopsys Common Licensing, follow these steps to obtain the Host ID 
for the dongle.

1. Insert the USB dongle in an active USB port. A light glows at the end of the dongle when it’s 
inserted correctly in an active USB port.

1. Click the Windows Start button and select Synopsys SCL > lmhostid 2022.12.

A command window is displayed.

2. Enter the command lmhostid -flexid, shown in the following example.
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The example shows a single Host ID, but the command may return multiple values (depending on 
your machine). You can use any single value.

3. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See 
Retrieving License Keys on page 58 for instructions.

After you retrieve your license key, go to Installing a License Key File for an SCL Nodelocked 
License on page 39.

Installing a License Key File for an SCL Nodelocked License
If you didn’t have or specify the location for your license key file when you installed LightTools, you 
can follow these steps to install it. 

This procedure assumes that you have already obtained a valid license key file from the SolvNetPlus 
SmartKeys web page. If you have not done so, see Retrieving License Keys on page 58 for 
instructions.

Follow these steps to install your license key file.

1. If you are using a dongle for Synopsys Common Licensing, insert the USB dongle in an active 
USB port. A light glows at the end of the dongle when it’s inserted correctly in an active USB port. 

2. Start the wizard to configure licensing in either of the following ways:

– Click the Windows Start button and select LightTools(64) [version] > Configure Licensing 
(LT[version]).

– Start LightTools. When the License Error dialog box is displayed, click the Configure 
Licensing button.

The License Type Setup screen is displayed, showing the type of license specified for your 
computer.

3. Click Next.

The License Key File Setup screen is displayed.

4. Enter the full path and file name or click the Browse button, navigate to the file, and select it the 
Windows Open dialog box.

5. Click Next on the License Key File Setup screen.

The SCL Installer Setup screen is displayed.

6. Leave the input field blank and click Next to accept the current version.

When the progress screen closes in the Setup - Optical/Photonic Solutions Licensing wizard, the 
license key file is installed and ready to use.
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Modifying License Options for Synopsys Common Licensing
Nodelocked and network server license types require unique license key files, so they are not 
interchangeable. If you have both a nodelocked license and a network license, you can change the 
type of license used to run LightTools after installation. 

For a network client, you can also use this tool to change the information needed to connect with the 
network server. Follow these steps to change the license information.

1. Click the Windows Start button and select LightTools(64) [version] > Configure Licensing 
(LT[version]). 

The License Type Setup screen is displayed.

2. Select the option you want and click Next.

3. Based on your selection, do one of the following:

– For Nodelocked or Network (Server Installation), enter or browse to the license key file and 
click Next. On the SCL Installer Setup screen, leave the input field blank an click Next to 
accept the current version.

– For Network (Client Installation), enter the name of the server on the Network Client Setup 
screen and click Next.

The licensing option is updated, and the setup wizard is closed.
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Chapter 5 Installing and Managing an SCL 
Network License

With LightTools Synopsys Common Licensing, you can run LightTools using either a nodelocked 
license or a network license. This chapter describes how to install the product to run using a network 
license on a network server, which allows you to run LightTools on any computer on the same 
network, and describes how to install LightTools on one or more client machines. 

Each license server makes available a number of LightTools product module licenses, and each 
license permits you to run eight concurrent sessions of LightTools. The total number of licenses are 
determined by your company’s license agreement. The total number of sessions may be shared across 
client computers. 

For example, if a license server has two licenses available, and each license allows up to eight 
concurrent LightTools sessions, then one client computer could use eight sessions from the first 
license and eight sessions from the second license. If the client computer used only three sessions 
from the second license, then the remaining five sessions would still be available and could be used by 
another client computer.

Synopsys Common Licensing controls the network license capability. If you install other Synopsys 
Optical Solutions software products, they will use the same license management software, and their 
license keys will be written to the same license key file. If you are already using Synopsys Common 
Licensing at your site, contact LightTools Support before continuing.

The steps for installing LightTools to run with a Synopsys Common Licensing license are:

1. Selecting a License Server on page 41

2. Installing LightTools with SCL Network Licensing on page 42

3. Obtaining the Host ID for a Dongle on page 45

4. Installing a License Key for an SCL Network License on page 46

5. Installing LightTools on Client Machines on page 47

6. Optional: Modifying License Options for Synopsys Common Licensing on page 49

7. Optional: Managing Network Licenses on page 50

Selecting a License Server
Before installing any software, you must identify the computer that will act as the license server. This 
must be a computer connected to a network that client machines can communicate with.

Note:  Installing a network license requires system-administration-level training and should be 
performed by someone who is familiar with your network structure. To perform this installation, you 
must be logged on as administrator.
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You can run the Synopsys Common Licensing server on the following operating systems: Windows 
10, Windows 11, Windows Server 2016, and Windows Server 2019.

System requirements for a Synopsys Common Licensing server are available here: https://
www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-
os.html.

Installing LightTools with SCL Network Licensing
The Synopsys Common Licensing software is included in the LightTools installer. Follow these steps 
to install Synopsys Common Licensing on the computer you have designated as the license server.

1. Log on to your computer as Administrator.

2. Navigate to the folder where the LightTools installation file LightTools64_2024.03FCS.zip is 
located. 

3. Right-click the file and select one of the extract options on the pop-up menu, shown in the 
following figure. For example:

– If you have WinZip, select WinZip > Extract to. In the WinZip Extract dialog box, navigate to 
the desired location on your local drive and click Unzip.

– If you have 7-Zip, select 7-Zip > Extract files. In the Extract dialog box, navigate to the desired 
folder and click OK.

– If you have the Windows extract tool, select Extract All. In the Extract Compressed (Zipped) 
Folders dialog box, navigate to the desired folder and click Extract.

4. When the extraction is complete, navigate to the folder to which the files were extracted.

5. Double-click the file setup.exe.

If a User Account Control dialog box is displayed with the message Do you want to allow this app 
to make changes to your PC?, click Yes to continue.

6. If you are prompted to install a Microsoft Visual C++ redistributable package or the .NET 
Framework, click the Install button.

The InstallShield Wizard is displayed.

7. Click Next to continue.

The Synopsys End-User Software License and Maintenance Agreement screen is displayed.

8. Click the I accept option and click Next to continue.

The Destination Folder screen is displayed.

9. To accept the default location for the program and Shared Data files, click Next.

The License Installation Options screen is displayed, and the default setting is for a Fixed/
Nodelocked license.

Note:  By default, Synopsys Common Licensing communicates via port 27020, the server port, as well 
as 27021, the vendor daemon port. If you will be running LightTools across different subnets, you will 
have to configure your routers or firewalls to allow two-way communication across your designated 
port. When specifying the server name for a network client, specify the server port and the server name 
or IP address (e.g., 27020@MyServer or 27020@123.456.78.90).

https://www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-os.html
https://www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-os.html
https://www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-os.html
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Of these four options, two are appropriate to use for an SCL network server configuration, as 
described below.

– I have a license file for a Fixed/Nodelocked license: This option applies to a nodelocked 
license, so it is not appropriate for this procedure.

– I want to connect to a license server to use a Floating/Network Client license: This option 
is used to set up a network client, so it is not appropriate for this procedure.

– Let me specify the licensing method manually: Select this option to set up a license server, 
specify a license key file, and optionally install LightTools on the same computer. 

a. Click Next, select Synopsys Common Licensing (SCL), and click Next again. 

b. On the License Type Setup screen, select Network (Server Installation) and click Next.

c. Enter the full path and file name or click the Browse button, navigate to the file, select it, 
and click Open.

If you do not yet have a license key file, you can install it later. Click Next and skip to step 
11. When you’re ready to get your license key file, see Obtaining the Host ID for an SCL 
License on page 44 and Installing a License Key for an SCL Network License on page 46.

d. On the License Type Setup screen, click Next.

When the progress screen closes in the Setup - Optical/Photonic Solutions Licensing 
wizard, the installation of the Synopsys Common Licensing software is complete.

Go on to step 10.

– Install LightTools without setting up licensing: This option allows you to install LightTools 
without setting up licensing at this time. If you want to do this, go on to step 10.

10. The LightTools Setup Type screen is displayed, shown in the following figure. You can do either 
of the following.

– If you want to install LightTools on this computer, continue with the next step. 

– If you do not want to install LightTools on this computer, click Cancel and then Finish to 
complete the installation.

11. Select the type of installation you would like to run and click Next.
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12. On the Ready to Install the Program screen, click the Install button to begin installing LightTools.

13. When the installation is complete, click Finish to close the wizard.

Working with Synopsys Common Licensing
Although Synopsys Common Licensing is a stand-alone application with many features and utilities, 
the LightTools installer includes the version of Synopsys Common Licensing recommended by 
Synopsys Optical Solutions for working with LightTools. The LightTools installer automates the 
installation and configuration of Synopsys Common Licensing for you.

The complete documentation for Synopsys Common Licensing is installed with the Synopsys 
Common Licensing components installed with LightTools in C:\Synopsys\SCL\[SCLversion]\doc, 
and it is also available on SolvNetPlus.

Obtaining the Host ID for an SCL License
A license key is associated with a unique value on your device called a Host ID, and it works for only 
one computer or USB dongle. Because of this, you need to know the Host ID for your computer or 
dongle before you can retrieve a license key file.

Obtaining the Host ID for a Computer
If you are not using a dongle, you can use the lmhostid utility installed with Synopsys Common 
Licensing to obtain the Host ID for your computer. Follow these steps to run the lmhostid utility.

Note:  During a Complete installation, all LightTools features are automatically installed, including 
the large CATIA V5 data exchange module. If you do not intend to license and use the CATIA V5 
module, you can choose the Typical setup option to install all features except the CATIA V5 
module, or select the Custom setup option, which allows you to manually control which features 
are installed.
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1. Click the Windows Start button and select Synopsys SCL > lmhostid 2022.12.

The Host ID is displayed in a command window, as shown in the following example.

2. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See 
Retrieving License Keys on page 58 for instructions.

After you retrieve your license key, go to Installing a License Key for an SCL Network License on 
page 46.

Obtaining the Host ID for a Dongle
If you are using a dongle for Synopsys Common Licensing, follow these steps to obtain the Host ID 
for the dongle.

1. Insert the USB dongle in an active USB port. A light glows at the end of the dongle when it’s 
inserted correctly in an active USB port.

1. Click the Windows Start button and select Synopsys SCL > lmhostid 2022.12.

A command window is displayed.

2. Enter the command lmhostid -flexid, shown in the following example.
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The example shows a single Host ID, but the command may return multiple values (depending on 
your machine). You can use any single value.

3. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See 
Retrieving License Keys on page 58 for instructions.

After you retrieve your license key, go to Installing a License Key for an SCL Network License on 
page 46.

Installing a License Key for an SCL Network License
If you didn’t have or specify the location for your license key file when you installed Synopsys 
Common Licensing, you can follow these steps to install it. 

This procedure assumes that you have already obtained a valid license key file from the SolvNetPlus 
SmartKeys web page. If you have not done so, see Retrieving License Keys on page 58 for 
instructions.

Follow these steps to install your license key file.

1. If you are using a dongle for Synopsys Common Licensing, insert the USB dongle in an active 
USB port. A light glows at the end of the dongle when it’s inserted correctly in an active USB 
port. 

2. Click the Windows Start button and select LightTools(64) [version] > Configure Licensing 
(LT[version]).

The License Type Setup screen is displayed, showing the type of license specified for your 
computer.

3. Click Next.

The License Key File Setup screen is displayed.

4. Enter the full path and file name or click the Browse button, navigate to the file, and select it the 
Windows Open dialog box.

5. Click Next on the License Key File Setup screen.

The SCL Installer Setup screen is displayed.

6. Leave the input field blank and click Next to accept the current version.

When the progress screen closes in the Setup - Optical/Photonic Solutions Licensing wizard, the 
license key file is installed and ready to use.
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Installing LightTools on Client Machines
LightTools must be installed on each client machine where it will be used. During the installation, you 
select Network (Client) as the license type and then specify the name of the server, which is the 
computer on which the license manager is installed.

These instructions assume that you have already downloaded LightTools from the Synopsys 
SolvNetPlus website via electronic software transfer (EST) or that you ordered and received a 
LightTools DVD. If you have not done so, see Using SolvNetPlus to Obtain LightTools Software and 
Licenses on page 51.

1. Log on to your computer as Administrator.

2. Navigate to the folder where the LightTools installation file LightTools64_2024.03FCS.zip is 
located. 

3. Right-click the file and select one of the extract options on the pop-up menu, shown in the 
following figure. For example:

– If you have WinZip, select WinZip > Extract to. In the WinZip Extract dialog box, navigate to 
the desired location on your local drive and click Unzip.

– If you have 7-Zip, select 7-Zip > Extract files. In the Extract dialog box, navigate to the desired 
folder and click OK.

– If you have the Windows extract tool, select Extract All. In the Extract Compressed (Zipped) 
Folders dialog box, navigate to the desired folder and click Extract.

4. When the extraction is complete, navigate to the folder to which the files were extracted.

5. Double-click the file setup.exe.

If a User Account Control dialog box is displayed with the message Do you want to allow this app 
to make changes to your PC?, click Yes to continue.

6. If you are prompted to install a Microsoft Visual C++ redistributable package or the .NET 
Framework, click the Install button.

The InstallShield Wizard is displayed.

7. Click Next to continue.

The Synopsys End-User Software License and Maintenance Agreement screen is displayed.

8. Click the I accept option and click Next to continue.

The Destination Folder screen is displayed.

9. To accept the default location for the program and Shared Data files, click Next.

The License Installation Options screen is displayed, and the default setting is for a Fixed/
Nodelocked license.

Of these four options, three are appropriate to use for a network client configuration.

– I have a license file for a Fixed/Nodelocked license: This option is not a valid for setting up a 
network client.

– I want to connect to a license server to use a Floating/Network Client license: Select this 
option to specify your server name and allow LightTools to detect the licensing method. Click 
Next.

On the next screen, enter the server name. In the following figure, the name OpticServer is used 
as an example; be sure to enter the name of your license server in this field. 
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If you want to enter more than one server name, you can do so, as long as you separate the 
names with a semicolon, as shown in the following example. The names ServerHostname1 and 
ServerHostname2 are examples; be sure to enter the names of your license servers in this field. 
LightTools checks for a license on servers in the order in which they are listed.

Go on to step 10.

– Let me specify the licensing method manually: Select this option if you already know and 
prefer to specify the licensing method. 

a. Click Next, select Synopsys Common Licensing (SCL), and click Next again. 

b. On the License Type Setup screen, select Network (Client Installation) and click Next.

When the progress screen closes in the Setup - Optical/Photonic Solutions Licensing 
wizard, the Synopsys Common Licensing software installation is complete.

The LightTools Setup Type screen is displayed, shown in the following figure.

c. On the Network Client Setup screen, enter the name of the port and the computer on which 
the Synopsys Common Licensing Network (Server Installation) software is installed as 
shown in the following example. 

If you want to enter more than one server name, separate the names with a semicolon, as 
shown in the following example. The names MyServer1 and MyServer2 are examples; be 
sure to enter the names of your license servers in this field. LightTools checks for a license 
on servers in the order in which they are listed.
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When the progress screen closes in the Setup - Optical/Photonic Solutions Licensing 
wizard, the Synopsys Common Licensing software installation is complete.

10. Click Next.

The LightTools Setup Type screen is displayed, shown in the following figure.

11. Select the type of installation you would like to run and click Next.

12. On the Ready to Install the Program screen, click the Install button to begin installing LightTools.

13. When the installation is complete, click Finish to close the wizard.

Modifying License Options for Synopsys Common Licensing
Nodelocked and network server license types require unique license key files, so they are not 
interchangeable. If you have both a nodelocked license and a network license, you can change the 
type of license used to run LightTools after installation. 

For a network client, you can also use this tool to change the information needed to connect with the 
network server. Follow these steps to change the license information.

1. Click the Windows Start button and select LightTools(64) [version] > Configure Licensing 
(LT[version]). 

The License Type Setup screen is displayed.

2. Select the option you want and click Next.

3. Based on your selection, do one of the following:

– For Nodelocked or Network (Server Installation), enter or browse to the license key file and 
click Next. On the SCL Installer Setup screen, leave the input field blank an click Next to 
accept the current version.

Note:  During a Complete installation, all LightTools features are automatically installed, including 
the large CATIA V5 data exchange module. If you do not intend to license and use the CATIA V5 
module, you can choose the Typical setup option to install all features except the CATIA V5 
module, or select the Custom setup option, which allows you to manually control which features 
are installed.
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– For Network (Client Installation), enter the name of the server on the Network Client Setup 
screen and click Next.

The licensing option is updated, and the setup wizard is closed.

Managing Network Licenses
In general, there is nothing that you need to do to manage the network licenses. As long as the 
network license server machine is operational, connected to the network, and is running the Synopsys 
Common Licensing (SCL) service, licenses are available to clients.

Synopsys Common Licensing provides tools that enable you to fine tune how your licenses and 
sessions are distributed using Options files. For information about using Options Files, see 
“Managing the Options File” in the FlexNet Publisher License Administration Guide, which is 
installed in C:\Synopsys\SCL\[SCLversion]\doc and available on SolvNetPlus. 
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Appendix A Using SolvNetPlus to Obtain 
LightTools Software and Licenses

Software and license keys for LightTools are available for download from the Synopsys SolvNetPlus 
website. This appendix describes how to use the website to download this software product and the 
license keys required to use it.

Special terms used in these instructions are explained in the Glossary on page 67.

The process is described in the following procedures.
1. Signing Up for a SolvNetPlus Account on page 52
2. Downloading LightTools Software from SolvNetPlus on page 53

or
Ordering Media (CDs/DVDs) on page 56

3. Installing LightTools on page 58
4. Retrieving License Keys on page 58

Note:  For customers working with distributors, please contact your local LightTools software 
distributor to obtain your software and license. See the Synopsys Optical Solutions Group Global 
Contacts page for contact information.

https://optics.synopsys.com/support/support-global-contacts.html
https://optics.synopsys.com/support/support-global-contacts.html
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Signing Up for a SolvNetPlus Account
Before you can download LightTools software and license keys, you must sign up for a Synopsys 
SolvNetPlus account. If you already have a SolvNetPlus account, you can skip to Downloading 
LightTools Software from SolvNetPlus on page 53.

1. Go to https://solvnetplus.synopsys.com and click REGISTER - CREATE ACCOUNT.

2. Follow the instructions for SolvNetPlus Self Registration.
SolvNetPlus will send a verification code to the email address you specified. You must retrieve the 
code and enter it on the SolvNetPlus site to complete your registration.

During the registration process, you also need to enter your company’s Site ID. If you do not 
know your company’s Site ID, please contact solvnetplusfeedback@synopsys.com to request it. 
Be sure to include your company name and address in the email request.

https://solvnetplus.synopsys.com
mailto:solvnetplusfeedback@synopsys.com
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Downloading LightTools Software from SolvNetPlus
Follow these steps to download the LightTools product. If you are unable to download software, you 
can order a CD or DVD instead. See Ordering Media (CDs/DVDs) on page 56 for instructions.
1. Go to https://solvnetplus.synopsys.com and enter your User Name and Password to sign in. 
2. Click Downloads.

All Synopsys products currently licensed at your company will be listed.

3. Select the product you want to download. 

4. Select the version you would like to download.

https://solvnetplus.synopsys.com
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The Download Details page is displayed, shown in the following figure.

5. Under Release Alerts, click the Sign Up link to display Release Alerts options that allow you to 
subscribe to Release Notification emails from SolvNet. These emails let you know when a new 
version of LightTools is available for download.
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a. Click the product name for which you would like to receive notifications or click ALL to 
receive notifications for all products in the list.

b. Click the Add button.
c. Click the Include patch notifications check box. This allows you to receive notifications of 

service releases for the selected products.
d. Click the Update button.
You are returned to the Download Details page. 

6. On the Download Details page, click Download Here.
7. On the Notice page, click Agree and Sign In to continue.

8. From the list of available files, click the name of the file and then use your browser to open or save 
the file.

The following figure shows a list of files for LightTools version 9.1-1.

– checksum_info.txt is a file used for internal purposes.

– FloatingLM.exe is for customers using LightTools Legacy licensing with a floating license. 
Only the system administrator who will set up a floating license server needs to download this 
file. See Installing and Managing the OSG Floating License (Legacy Licensing) on page 17 for 
installation instructions.

– LightTools64_911SR1.zip is the installation file for LightTools.

– README_LightTools_9.1.1SR1.txt provides a summary of key features in the release.

– w_mpi-rt_p_2018.2.185.exe is the Intel Message Passing Interface (MPI) executable required 
for the Distributed Simulation Module.

Next steps:

• If you need to obtain a license key, see Retrieving License Keys on page 58.

• If you already have a license key, see one of the following procedures, based on the licensing 
you’re using:

– Installing LightTools with a Fixed License (Legacy Licensing) on page 9 

– Installing and Managing the OSG Floating License (Legacy Licensing) on page 17.

– Installing LightTools with an SCL Nodelocked License on page 35

– Installing and Managing an SCL Network License on page 41
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Ordering Media (CDs/DVDs)
If you are unable to download software and would like to order media (CD or DVD) instead, you can 
do this directly on the Synopsys SolvNet website. Follow these steps to order media.

1. Go to https://solvnetplus.synopsys.com and enter your User Name and Password to sign in. 
2. Click Downloads at the top of the page.
3. Click the MEDIA CENTER link.

4. On the MEDIA CENTER page, select the product (e.g., CODE V, LightTools, LucidShape, etc.) 
and click the Add button.

5. Complete the Shipping Address information and click Continue.

6. Review the shipping request, shown in the following figure, and click Place Order.

https://solvnetplus.synopsys.com
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Installing LightTools
Instructions for installing LightTools software and license keys are provided in the following 
chapters:

• Getting Started on page 5 - Lists LightTools system and licensing requirements and tells you how 
to contact LightTools Support.

• Installing LightTools with a Fixed License (Legacy Licensing) on page 9 - With a fixed license, 
you install the LightTools product, dongle, and license key file on the computer where you want to 
run LightTools.

• Installing and Managing the OSG Floating License (Legacy Licensing) on page 17 - With a 
floating license, you install the dongle and license key file on a network server and the product on 
one or more client machines where you want run LightTools; you also install the OSG Floating 
License Manager on the network server to manage the licenses.

• Installing LightTools with an SCL Nodelocked License on page 35 - With a nodelocked license, 
you install the dongle (if you’re using one), Synopsys Common Licensing software, LightTools 
product, and license key file on the computer where you want to run LightTools.

• Installing and Managing an SCL Network License on page 41 - With a network license, you install 
the dongle (if you’re using one), Synopsys Common Licensing software, and license key file on a 
network server and then install the product on one or more client machines where you want run 
LightTools.

After you install the LightTools product, continue with Obtaining the Host ID on page 58.

Obtaining the Host ID 
A license key is associated with a unique value on your device called a Host ID, and it works for only 
one computer or USB dongle. Because of this, you need to know the Host ID for your computer or 
dongle before you can retrieve a license key file. Based on the licensing you’re using, see one the 
following procedures.

for LightTools Legacy Licensing:

• Fixed license - Obtaining the Host ID for a Fixed License on page 11

• Floating license - Obtaining the Host ID for a Floating License on page 20

for Synopsys Common Licensing:

• Nodelocked license - Select the type of installation you would like to run and click Next. on page 
37

• Network (Server) license - Obtaining the Host ID for an SCL License on page 44

After you obtain the Host ID, continue with Retrieving License Keys on page 58.

Retrieving License Keys
A license key is a file containing licensing information for your specific USB dongle. You can obtain 
license keys using the SmartKeys web page on the Synopsys SolvNetPlus website. Follow these steps 
to obtain your license keys.
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1. On the SolvNetPlus home page, click Downloads and then click the SmartKeys tab.

2. On the SmartKeys Home page, click the Key Retrieval link.

The SmartKeys Key Retrieval page is displayed. 

You can retrieve a license key for a single USB dongle, or you can retrieve license keys for all 
Host IDs at your company. 

3. To obtain a license key for a single USB dongle, enter the Host ID of your LightTools USB dongle 
in the Host ID (Optional) field. 

If you do not know the Host ID value for your USB dongle, see Obtaining the Host ID on page 58.

To obtain license keys for all products and all Host IDs at your company, leave the Host ID 
(Optional) field blank. 

4. Click Retrieve Key, shown in the following figure.
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Your LightTools license key will be delivered as a text file attached to an email from the 
SmartKeys system. If you did not enter a Host ID in step 3, you will receive a separate email with 
a single license key attached for each Host ID at your company. The email will include the Host 
ID for which the license key is valid. 

5. Save the license key to a convenient location on your computer. You need to access this file to 
activate LightTools. 

6. See one of the following procedures for instructions on installing the license key to activate your 
LightTools product.

for LightTools Legacy Licensing:

– Installing a License Key for a Fixed License on page 12

– Installing a License Key for a Floating License on page 21

for Synopsys Common Licensing:

– Installing a License Key File for an SCL Nodelocked License on page 39

– Installing a License Key for an SCL Network License on page 46
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Appendix B Troubleshooting the LightTools 
Legacy Floating License Installation

If a security problem occurs when you use a LightTools floating license, a License Manager Error 
dialog box displays an error message. Below are a few common security errors with their causes and 
resolutions. If you are unable to correct the problem, contact LightTools Support at 
lighttools_support@synopsys.com.

Problem Adding License Keys to the License Server

Problem:  Sentinel: Error [19]: Failed to add license code …

Cause: This general error message indicates that the license keys were not applied successfully in 
the license manager. This can occur if the file where the codes were being read is 
corrupted. However, this error an also occur if license keys that have already been 
successfully entered are entered a second time.

Solution: Verify that the license file contains license keys for the current version of LightTools 
being installed, and not for an earlier version (the version number is listed in the 
comments of the license file received from Synopsys). Also verify that the license file has 
not become corrupted. This might occur if the license file has been edited (i.e., lines 
containing license keys are changed or become line wrapped incorrectly). When you 
install a license key, follow the procedure Installing a License Key for a Floating License 
on page 21.

Problems Starting LightTools

Problem: Error #18b - No valid license code for version x.x.x found. 

Cause: There has not been a valid license key entered for this version of LightTools.

Solution: See Installing a License Key for a Fixed License on page 12 for instructions on installing 
license keys.

Problem: Error #0xC800100D - License code for version x.x.x has expired. 

Cause: The license key for LightTools has expired, or the PC date is before the start date of the 
license.

Solution: Verify that the date on the computer is correct. Install the license key for this version of 
LightTools on the license manager machine according to the instructions in Installing a 
License Key for a Floating License on page 21. If a new license key is needed, contact 
LightTools Support.

mailto:lighttools_support@synopsys.com
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Problem: Error #8001008 - License manager is not responding. Verify license manager host is 
available and license manager process is running.

Cause: The Sentinel Floating License Manager program has been disabled.

Solution: Restart the license manager program. To do this, open the Control Panel (select Start > 
Settings > Control Panel), select Administrative Tools and then Services. Locate and 
right-click Sentinel RMS License Manager in the dialog box, and select the Start option 
on the pop-up menu.

Cause: The license manager machine is unavailable.

Solution: Verify that the license manager machine is available on the network.

Cause: The ORA_LSHOST environment variable is not set or is incorrectly set.

Solution: Change the Hostname with the Program > Change option, as follows: Windows Start 
button > Control Panel > Programs > Uninstall a Program. Select LightTools and 
click Change on the menu bar. Select Next > Modify > Change Licensing Options > 
Next > Floating License. Enter a name for the Server Hostname. Click Next > Install > 
Finish.

Problem: An unexpected licensing error has occurred.

Cause: An error has occurred with the license manager. The License Manager Error dialog box 
will contain more specific information about the problem, which is provided by the 
Sentinel Floating License Manager program. If you are still having difficulties identifying 
the problem, contact LightTools Support for guidance.
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Appendix C Troubleshooting Synopsys 
Common Licensing

This appendix lists licensing errors that you might encounter with Synopsys Common Licensing and 
describes probable causes and resolutions. If you are unable to correct the problem, contact 
LightTools Support at lighttools_support@synopsys.com.

The LightTools installer includes the following components for Synopsys Common Licensing:

• Optical/Photonics Solutions Licensing components version 2023.12

• Synopsys Common Licensing version 2022.12

For Nodelocked and Network (Server Installation) installations, the LightTools installer configures 
the Synopsys Common Licensing server as the Flexlm Service 1 service.

Error messages may refer to the flex log, which is the log file for Synopsys Common Licensing. This 
is the file flexlog.txt in the folder C:\Synopsys\licenses

Synopsys Common Licensing always includes a Synopsys Common Licensing server. Even when you 
have a nodelocked installation, there is an instance of the Synopsys Common Licensing server 
running on your system. Therefore, even when you are not using a networked license, you may have 
issues communicating with the Synopsys Common Licensing server.

There are no remaining licenses for the requested feature
Licensed number of users already reached.

A limited number of users can use this feature at the same time, and the limit has been reached.

mailto:lighttools_support@synopsys.com
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If you are running multiple sessions concurrently, you may have reached the maximum concurrent 
session limit.

For network licenses, wait for other users to end their feature usage, then try again.

To further check license usage at your site, contact your SCL license administrator.

The license does not include the requested feature
No Such Feature Exists

The license file found does not contain a valid feature for this version of the software.

Check with your LightTools administrator for the valid features.

Cannot connect to the license server system
The license is not available. LightTools cannot run due to a licensing issue.

The license server manager (lmgrd) has not been started yet, the wrong port@host or license file is 
being used, or the port or hostname in the license file has been changed.

This error can occur for the following reasons:

• (lmgrd) daemon is not running

The LightTools installer configures this as the Flexlm Service 1 service. Confirm that the Flexlm 
Service 1 is running on your Nodelocked or the Network (Server) system. If you cannot find the 
Flexlm Service 1 service, try the following:

– Reboot the system.

– Configure your licensing again.

See Modifying License Options for Synopsys Common Licensing on page 49 to reconfigure the 
selected license type.

– Contact LightTools Support.

• Wrong port/host or license is being used

See Modifying License Options for Synopsys Common Licensing on page 49 to update the host 
name and port number for the license server.

• License file has expired.

If your license agreement is current, you can request an updated license from SolvNetPlus or from 
LightTools Support.

If you need to renew your license agreement, contact optics@synopsys.com or your local 
distributor. 

• License file contains an invalid Host ID

– Contact LightTools Support.

• License file is not installed

See Modifying License Options for Synopsys Common Licensing on page 49 to install the license 
file.

mailto:optics@synopsys.com
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For nodelocked licenses, the licensing processes can be stopped in some situations and do not 
automatically restart; when you try to start the software, you will see an error stating that 
LightTools Cannot connect to the license server system. If this happens, you 
need to restart your computer to restart the licensing processes.

A connection to the Synopsys Common Licensing license manager was lost
The complete error message is:

A connection to the Synopsys Common Licensing license manager was 
lost, and the application has exhausted all of its retry attempts.

Cannot connect to license server system.

For network licenses, check your network connection to your network license server.

For nodelocked licenses, reboot your computer, then try again.

If the error persists, contact lighttools_support@synopsys.com or your local distributor. 

Include the following:

• A screenshot of the License Manager Error window

• The following files from the licenses folder. (The default location is C:\Synopsys\licenses.)

– opslic.txt

– flexlog.txt

The license request was denied by the network license server
This error message can be received from multiple scenarios.

• The User/Host on EXCLUDE list for feature (FlexNet Licensing error: -38, -101)

• User/host not on INCLUDE list for feature (FlexNet Licensing error: -39)

• Checkout exceeds MAX specified in options file (FlexNet Licensing error: -87)

Contact your SCL license administrator.

This error can occur for one of the following reasons:

• Max limit of users has been reached.

• You have been excluded from using this feature.

• The feature is reserved for others.

Time Tamper Error
A problem with the system clock has been detected.

The system clock is currently set incorrectly, or has been set incorrectly in the past. Contact 
lighttools_support@synopsys.com or your local distributor and provide a copy of the error message, 
including the Host ID mentioned in the error message.

mailto:lighttools_support@synopsys.com
mailto:lighttools_support@synopsys.com
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LightTools cannot find the Synopsys licensing service/daemon (snpslmd)
The Synopsys licensing service/daemon (snpslmd) is either down or inaccessible. The Synopsys 
licensing service/daemon can terminate because of the following reasons:

• All the features have expired for this version of the software.

• The license file is corrupted.

• The license file contains an invalid server Host ID.

If you are using a network license, your connection with the computer hosting the license service/
daemon may have been interrupted. Check your network connection.

Firewalls must be configured to allow the Synopsys Common Licensing server (lmgrd.exe and 
snpslmd.exe) to communicate on ports 27020 and 27021. If you get an error such as a -96 FlexNet 
Licensing error, make sure that both ports are open in any firewalls.

If you are using a nodelocked license, ensure that the Flexlm License 1 service is running.

Uninstall Synopsys Common Licensing

If instructed by LightTools Support, you can remove Synopsys Common Licensing components from 
a system. Note that the Remove option in the LightTools installation wizard does not remove the 
Synopsys Common Licensing components.

Follow these steps to remove the Synopsys Common Licensing components.

1. Log in to your system as an administrator.

2. Open Add and Remove Programs.

3. Uninstall Optical/Photonic Solutions Licensing.

4. Uninstall SCL [version].

5. Restart the system.

6. (Optional) Delete the folder C:\Synopsys only if you have no other Synopsys applications using 
that folder.

Caution:  Do not remove the Synopsys Common Licensing server unless you have confirmed that no 
other Synopsys products are using the Synopsys Common Licensing server instance.
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Glossary

Fixed License Used with LightTools Legacy Licensing. A license associated with a specific USB dongle.
Floating License Used with LightTools Legacy Licensing. A license managed by the OSG Floating License 

Manager.
Host ID A string used to identify a computer or a USB dongle. The Synopsys SmartKeys site and 

delivery email reference the Host ID value when license key files are requested and delivered.
LightTools Legacy 
Licensing

The method of licensing used in releases up to and including LightTools 2023.03. It is based 
on the Sentinel License Manager.

License Key File A file containing the encoded license information needed to run LightTools for a specific 
computer or USB dongle.
Note that license key files are unique for each method of licensing and are not 
interchangeable.

Network License Used with Synopsys Common Licensing. A license managed by the Synopsys Common 
Licensing server.

Nodelocked License Used with Synopsys Common Licensing. A license associated with a specific computer or 
USB dongle.

Site ID A number used to identify a specific company. Every company that uses LightTools and other 
Synopsys software has a unique site ID.

SmartKeys A page on the Synopsys SolvNetPlus website where you submit license key requests.
SolvNetPlus The Synopsys customer portal (https://solvnet.synopsys.com). Customers who register for an 

account on this site can download LightTools software and licensing software, and request 
license keys. 
SolvNetPlus also provides access to technical articles, example files, macros, release notes, 
and FAQs, as well as product documentation, product learning, self-help, and other resources.

Synopsys Common 
Licensing

The license management tool used by Synopsys. This method of licensing is available starting 
with LightTools version 2023.03. It is based on FlexNet Licensing.

https://solvnet.synopsys.com
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